
Passage Express – Step by Step Tutorial 

Note: This document was purposely kept small in order to make it downloadable by all, 
including those with a dialup modem.  This meant having very few illustrations.  It is 
meant to be used in conjunction with the regular Help screens found inside the software 
which have illustrations and explanations of the various windows contained in the 
software. The best way may be to jump right into the software and follow along.   Also, 
with this in mind, let us know how we can improve this document to better help you.  As 
we receive feedback from our customers, we are finding things in the software that may 
be confusing or that may be better situated on the screen, etc.  We will be making 
adjustments and you will be able to get the latest by using the automatic Check For 
Updates option.  This will happen automatically and requires an Internet connection.  
You can also trigger it manually by clicking on the Help drop down menu at the top of 
the Main Menu (see illustration below). 

Welcome Window 

The first screen you see is the Welcome screen that will allow you to choose an existing 
project, or choose to create a new project.  A portion of that window is shown below. 

 
After choosing a project, you will then be taken to the Main Menu. 

The Main Menu 

An illustration and explanation of the main menu would be in order here.  Refer to the 
illustration down below. 

The Projects button in the upper right part of the screen is a button that will take you to 
a list of the projects you have started.  There you can choose a project, open it, add 
general descriptive details or delete it.  There is also a button there to Import (From CD) 
a Passage Express project or a Family History CD project.  Just put your CD (whether or 
not it is a finished project) into your CD drive, click Import and it will help you through 
the rest.  After the Import is finished, be sure to highlight the new project that will now 



show up on your screen and the click “Open”.  (Do this before exiting this window.) This 
will finish the import process. 

As you look at the screen print of the main menu below, notice the column of links 
labeled: Project Builder, Video DVD, CD/DVD Label, Other Publishing Options.  Go 
to the Passage Express help screens found inside Passage Express and click on the plus 
(+) next to Main Menu.  To get to the help screens, click on a blue and white question 
mark button or click the Help drop down menu.  There you can see illustrations of each 
of these views of the Main menu.  

The box to the left of this column of links contains information and buttons leading to 
various options pertaining to the link that you clicked to the right.  The information 
changes depending on which link you clicked. 

Click on the Project Builder link to show the Project Builder information in the box at 
the left.  Then click the red Project Builder button to enter the Project Builder screens 
(labeled as First Step to starting your project in the illustration below).  This is where you 
will add and organize your files such as photos, documents, audio, video etc.  This is also 
where you will edit photos, add details to items, and other tasks. 

 
Three other links below the Project Builder link, namely, CD-ROM or DVD-ROM and 
Other Publishing Options show ways you can publish your project.  Because there are 
differences between the type of menu you create for CD-ROM/DVD-ROM and for Video 
DVD, the menu building screens and other options that relate to these individual 
publishing modes are to be found by clicking on the CD-ROM or DVD-ROM link or the 
Video DVD link.  Clicking on these will change the information in the box to the left. 
There you will find buttons to build your menu or to prepare to burn a disk or to test your 



project and see how it runs in the case of CD-ROM/DVD-ROM.  When you do this, it 
will be running as if you had inserted a CD with your project on it. 

It is probably best to go through the first tutorial entitled CD-ROM with sound for 
computer as what you learn there will be helpful later on. 

Step By Step Tutorial       

This can be used in conjunction with the existing help screens that have illustrations and additional 
information about the various functions and windows.  

On your first project, we suggest just making a small project with a few items to help you get 
accustomed to the software. 

Contents: What do you want to create?  

1. CD-ROM for computer 

2. DVD-ROM for computer 

3. Slideshow movie with music on a CD or DVD playable in a DVD player  

4. DVD of my home movies 

5. A Music CD 

6. Publish my Legacy, RootsMagic or PAF multi-media files  

7. Collaborate with a Relative in making a project 

8. Create a CD label 

9. Make picture collages 

 

 

 

 

 

 



1. CD-ROM with Sound for computer 

Steps:    (See details of each of these steps further down below.) 

1 Begin a new project 
2 Create folders for the subjects/items you want to feature. 
3 Add pictures, documents, GEDCOMS into the folder. 
4 Create a folder for music. 
5 Add your music files into this folder. 
6 Click slideshow icon. 
7 Add pictures to the slideshow 
8 Add music to the slideshow 
9 Add text slides 
10 Customize slideshow 
11 Test the slideshow 
12 Test the project 
13 Create a Front Page 
14 Publish to CD 

Step 1  Begin a New Project  

A. Open Passage Express.  Click Start New Project>Next. 
B. Title the project, author and details of the project>OK 
C. Click Project Builder.  This is a red button, if you don’t see the red button, click 

on the Project Builder link found on right side of the center area of the Main 
Menu. 

Step 2 Create Folders using the Project Builder 

1 On left side of screen, click Add Folder. (This will add a folder visible in the 
folder area) 

2 Name the folder. Just start typing or click the ‘rename’ button (example: 
Grandpa)   

3 Make more folders.  You can make them as subfolders by clicking on the arrow 
buttons at the bottom left of the screen. Example:  Grandpa’s childhood,  
marriage, employment, retirement.  You can click on the right arrow button to 
move it to the right as a subfolder under the folder ‘Grandpa’. 

Step 3 Add Computer files into the Folders 

First highlight a folder.   

1. Click Add Item on the right of the screen.   
2. Choose method for adding in files: 

a. Browse for file- on the hard drive – Try this one first. 
b. Import folder- from the hard drive (Will bring everything in the folder, including 

subfolders and contents.  If you don’t want to take the time to type details on 
every item that comes into your project, change the setting under the Options 



drop down menu at the top of the screen:  Options>Settings>General  uncheck 
“Open details when adding items”) 

c. Scan Image- using your scanner 
3. Add Details; descriptions, face labels, narratives, captions, welcome sounds, etc. 
4. Edit any picture: lighten, auto-crop, manual crop, rotate, flip, greyscale, colors, remove red-

eye, resize, rotate, sharpen.  Details button>Edit Image tab 
5. Put them in the preferred order.  Highlight item and click on the arrow buttons on lower right 

side to move the selected file up or down.   

Step 4  Add a Folder for Music  

1 Click ‘Add’ on left side of screen 
2 Name the folder (example: Music) 

Step 5   Add music files into this folder  

Click ‘Add Item’  

Browse for music files or ‘grab’ a track from a music CD that you own or add music from the 
Passage Express music library.  (Be careful of copyright issues.) 

Step 6   Make a slideshow (optional) 

The slideshow option allows you to make a slideshow from the photos you have already added to 
your project.  For simplicities sake you could either add “all photos”, if you don’t have too many, 
or add a few one at a time. 

Click slideshow icon found at the top tool bar (looks like a tiny movie screen) or under Add 
item>slideshow.  

Name the slideshow. 

Step 7   Add pictures to the slideshow  

With the slideshow window open, click Add in left side of screen.  Select individual pictures, this 
will take you temporarily to the Project Builder screen to select what photo you want to add.  
Right click on a picture item to add, then click Add to Slideshow on the little menu that appears.  
The project builder screen then will disappear. 

Step 8   Add music to the slideshow  

Note: Just like pictures, you must first have the music as a part of your project before you 
can add it to your slideshow.  You can add the music back in the project builder.  Click on 
the Add Item button>Sound Music 

Add just as you did when adding photos: Click Add in the music portion of screen. Upper right 
area. 

Right click on music item.  These items will become background music for your slideshow.   



At the bottom left hand side of the slideshow window, there is a link that explains: Click here to 
force the display times of the pictures, so that pictures end when music ends.  You must supply 
enough music to make the slides stay on the screen for a reasonable amount of viewing time.  For 
Example: You wouldn’t want to have a 3 minute music file with 100 photos and try to synch up 
the viewing time with the music. 

Step 9   Add text slides 

Click Add>Text slide in Slideshow screen (lower left side). 

Enter the text for the slide. Design it using fonts, backgrounds. 

After you create it, click on the arrow button to move the text slides up (or down) to the desired 
position in slideshow. 

Step 10  Customize Slideshow 

Double click on any picture or text slide in the slideshow to choose options for different 
transitions, display time, music timing.  You may need to slide the bottom scroll bar to the right 
to see the transitions.  Click on the little transition image to change it.  The default is Fade 
Simple. 

Add narratives to photos by choosing Edit>record. 

Step 11  Test the slideshow 

Click Test in the lower right screen. 

Make any changes to the slideshow after viewing the test. 

Step 13  Create Front page 

If you are in the slideshow screen, close it and save.  Close the Project Builder screen. 

Go to the Main Menu.  Click on the “CD-ROM or DVD-ROM” link near the center of the screen. 

Click on the red Design Front Page button. 

Here is where it would be good to take a look at the help screens in the Passage Express software.  
There are some good illustrations and instructions.  Open the help by clicking on a blue and white 
question mark button or click on the Help drop down menu then “contents”.  Look for the topic 
Front Page Designer and click the little plus (+) next to it. 

Step 14- Test Project 

Step 15-  Publish� 

Place blank CD in CD-writer, click burn CD. 



2. DVD-ROM with Sound for computer 
Use the same steps as CD-ROM (See section 1) except that you will have much more room for your project.  

You can adjust your size limits (used as a reminder of how much room you have left on a CD or 
DVD) by going to the Options drop down menu>Settings>Project Size 

1 Begin a new project  
2 Adjust project size for DVD 
3 Create folders for the subjects you want to feature. 
4 Add pictures, documents, GEDCOMS into the folder. 
5 Create a folder for music. 
6 Add your music files into this folder. 
7 Click slideshow icon. 
8 Add pictures to the slideshow 
9 Add music to the slideshow 
10 Add text slides 
11 Customize slideshow 
12 Test the slideshow 
13 Test the project 
14 Create a Front Page 
15 Publish to DVD 
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Note: It’s a good idea to try a small slideshow first to see how long it will take to create a movie.  
The amount of time it will take depends on your computer and the resources it has.  Movie files 
are very large.  Think about making a separate frame for each split second of movie just as there 
was on the old movie films.  The resulting files are very large and when you choose the Make 
Movie option, it may take over an hour to create a 10 minute movie of your slideshow.  You can 
test this ahead of time by making a small slideshow of 10 or less slides and watching how long it 
will take on your computer. 

Steps:  Same as making a slideshow above, except for the following steps 12, 13, and 14. 

1. Begin a new project. 
2. Create a folder for pictures. 
3. Add pictures into the folder. 
4. Create a folder for music. 
5. Add your music files into this folder. 
6. Click slideshow icon. 
7. Add pictures to the slideshow 
8. Add music to the slideshow 
9. Add text slides 
10. Customize slideshow 
11. Test the slideshow 
12. Make a movie of the slideshow 
13. Create Menu page 
14. Publish to DVD 

Steps 1 through 11 are covered above in CD-ROM With Sound For Computer. 

Step 12  Make a movie of the slideshow 

While in the slideshow window (see section on making a slideshow above) and after making a 
slideshow.  Click the Save button to save your slideshow. 

Click the Movie tab in the lower right screen.   

Each type of Movie has a different format: 

DVD, the one you are probably most familiar with. 

VCD (Video CD) can be made without a DVD drive in your computer and can be played in many 
DVD players.  Some DVD Players don’t support this format. 

SVCD (Super Video CD, better quality than VCD) can be made without a DVD drive in your 
computer and can be played in many DVD players.  Some DVD Players don’t support this 
format. 



After choosing what type of movie that you want to make, follow the on-screen instructions on 
making a movie.   

After the movie is created, you can burn the CD or DVD depending on which option you chose 
above, erase it, watch the movie on the default movie player on your computer (Some computers 
may not have a movie viewer) or you can make adjustments in your slideshow and start over 
(Create New Movie). 

Step 13  Create Menu page 

On the main menu, pick either “CD-ROM or DVD-ROM” or Video DVD depending on your 
project.  One project can have both.  Click on the Design Front Page (red button) 

There are some good instructions illustrations on using the Front Page designer in the regular 
Passage Express Help Screens.  There you will find a number of illustrations to help you build a 
Front Page Menu. 

4. DVD of my home movies 

Now you can burn any movie to a VCD, SVCD, or DVD (with menus).  If you have the old 
movies on film, then you may be able to find a professional who takes the old movies and 
converts them into a digital file format that can be used in Passage Express. 
 
Step 1 Transfer your movies from your digital camcorder to your computer or copy them from 
another location.  File formats that have a wide range of support between computers are AVI, 
MPG, MOV, WMV.   Other file types may also work.   
Step 2 Put these files on your computer 
Step 3 Start a new project or open an existing project 
Step 4 Make a folder or open your desired folder (See above) 
Step 5  Add your movie files into the folder, just as you did a photo 
Step 6  Right-click on the file and select "prepare for VCD", "prepare for SVCD", or "prepare for 
DVD."  
Step 7  Create a DVD menu  
Step 8  Publish to DVD. 
 

5. Music CD  

Steps: 

1. Begin a New Project 
2. Create a folder 
3. Put music files into the folder 
4. Design Front Page 
5. Test 
6. Publish 

 



6. Publish my Legacy, RootsMagic or PAF multi-media files  

1 Begin a new project  
2 Adjust project size for Thumbdrive, CD or DVD 
3 Click Import (Button with little green arrow on the toolbar on the Project Builder window) 
4 Follow instructions to import from one of these 3 softwares listed in the title of this section. 
5 After importing, adjust or enhance folders and files in project builder just as you normally 

would. 
6 You can make a slideshow. 
7 Add pictures to the slideshow 
8 Add music to the slideshow 
9 Add text slides 
10 Customize slideshow 
11 Test the slideshow 
12 Test the project 
13 Create a Front Page 
14 Publish  

7. Collaborate with a Relative in making a project 

Because you can import Passage Express CDs into your software, you can work with 
others on the same project.  This means that you can take a project that your family 
member has started and then you can import that project into your computer by using 
the Passage Express import function found on the Projects window.  You can then add 
to the project.  Find the projects window by clicking on the red Projects button in the 
upper right area of the main menu. 

1  Begin a new project  yourself and allow the other to begin one also using Passage Express. 
2 Adjust project size for Thumbdrive, CD or DVD (Options dropdown menu, 

Settings>Project Size 
3 Click Project Builder 
4 Adjust or enhance folders and files  
5 Create folders for the subjects you want to feature. 
6 Add pictures, documents, GEDCOMS into the folder. 
7 Y can make a slideshow that uses the music for a background. 
8 Add pictures to the slideshow 
9 Add music to the slideshow 
10 Add text slides 
11 Customize slideshow 
12 Test the slideshow 
13 Test the project 
14 Create a Front Page 
15 Publish to Thumbdrive, CD or DVD 
16 Receive the relative’s CD (Import button on the Projects window.  Click the Projects button 

on the Main menu.) 
17 Copy in their project to your PE software. 
18 Copy folders from their project into your project. 
19 Adjust your Front Page, if needed. 
20 Test your project 



21 Publish 

8. Create a CD label  

Steps: 

The CD label creator is very similar to the Image Designer and Front Page designer except that it 
supplies a visual guide in the shape of a CD/DVD.  Passage Express does not print the CD/DVD 
label directly.  But you can create the image here using the Passage Express tools.  You then 
create a jpg image that you save to your hard drive and then you use your own label printing 
software to do the printing. 

1. Click on the CD/DVD label link on the Main Menu. 
2.  You can import the Front page and rearrange it a little and use it as your CD/DVD label 

or you can start fresh. 
3. Move the pictures and titles to fit, remove the buttons if you wish.  This won’t affect the 

original front page. 
4. Export as a JPEG image to hard drive using the Save As Image button on the top toolbar 

of the Disc Label window. 
5. Open your label making software and paste this JPEG image into your CD label making 

software 
6. Print your CD label 

 

9. Make Picture collage 

The Image Designer is an easy way to make a nice looking image of almost any type that can be 
used for almost any purpose.  The Image Designer is almost identical to the Front Page Designer, 
except it doesn’t have the ‘buttons’.  See the Help screens in the Passage Express software.  Click 
on the plus (+) next to the Front Page Designer to see some good illustrations and instructions.  

1. Start New Project or open existing project 
2. Click Project Builder 
3. Click Image designer icon at the top tool bar 
4. Add pictures, shapes, titles (See Front Page Designer, above) 
5. Export as JPEG 
6. Close Image designer 
7. Use the JPEG file to add into your project or for any other purpose. 

 

 


